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TR Ge: SiqHel=d, fRaee?

Bk T 3AeH: F:?

TR, STHTATI 112

faiiy: IS ST ARFE: F Td Fa:?

T Hifed: T N1 &: IOT: E?

foiae st o Ster?

10)@: I& F1H 39 7
11) Fnai ihia: Fsar?
12) AR STTES! T: FIEaT TEd?
13) 7 fohmel e Setftrdae: ?

14) STTRo T HiEal HE5d FAH?
15) HreRiee Fisd:?

16) SIhreamEEEe Hisy: ?

17) snem: : ‘{ﬁﬂTﬂT: AEE?

18) TT: et 1l 53?

19) GFheaTRIAT 2TH FAATT 6 FHH?
20) H1: Fi qie=Etd &1?



21) 1 A IB: FIT AN F: I hel T8:?
22) fadia: =i gi: gfa sihwifa Fifeea: ?
B) I3 IgUIt SiHEt Q0 Foa1 ATt fFEal 5x4=20
1) FESTETE ... |
2) ﬁwﬁ:w: ....... |
3) T A & TR,
4) TR ..........

5) ESEISHaFE:......
C) g4I |H g 10x1=10
1) FfSEEFCRHISHAIRT: |

2) RIS
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RKMVERI/DSP/WW/MAIS/24-29/D2024/SK-411

SK-411 TgHaM, (TI0E:)

FISEN: - EREIH, qUITET: - 50

A) I A FATAH, I fSEal gxgo=20
1) fochi: sfe areqem wrdl: %:2
2) TR femee ot aftasfa?
3) s fraem faor:?
4) TEUTH e 83 AT FaaREEE Fi: IA:?

N o o o o

5) TH: HoEdd T [gfe: TAHHIY a1 S 26 S I [Heh: ?

6) WERE 3 Teaw &: ol ?

7) 3eg: eRferaniae 3 e STHEE?
8) Ue: 3 TeaE F: IY:?

9) ArE: 3fa Miadteh HRA f5g Tga?
10) e Fel: THH 3Aex?

11) R srefana e

12) 9T 5 2ae &: el ?

B) 998 U= i [4Gd | IXY=2Y
1) @ gawmE...
2) FFATFA...
3) FATATIRAT. .
4) dg<d...
5) HANAR...
6) ...
7) 9S4,



C) 7= st HwEt AT FEa|

N C ¢

1) TEMEH AN HUTg STHAEHA: T,
A G T g |
2) AT AR s |
A TG Ted Sl Tl
3) FARTEAT TG astal: Easal: |

4) FAE SUGT: TGRSR |
AU SRR alaeTaRant:
5) SrEnsUEfE Ryt 3|
AT ST, ES Fadi ak: |l
D) 998 T I fo@d
1) FGEE 9 HEgg Nl H3T TS 5@ |
2) fedive afaeemeEmER foed|
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RKMVERI/DSP/MAIS/23-28/D2024/SK-413

SK-413 ¥ &lﬁlﬁﬁ@r_da"{

FISEN: - EETH

TOTET: - 50

A) THA ITRA 934 91 I |

1)
2)
3)
4)
5)
6)
7)
8)
9)

ARG AESTE! Hifgd: & ifd ?

TrASIAT: THIYAT F: ST ?

1x10=10

NPT T g Thasig: R Rd?

o ﬂ.r\ f\?

P7EaSkaN _l% . .:"'S i1 77 [ NI N o ?

N_O o 03

“TTSEIR, fue: Haw:” e Feid ?

UE: FE Tell 1 3R ?
G HIAT HT STRA?
TIRgaeAl: [aaTE: e ?

10) AFes Ta=RE: F: ?

11) “&di & Fagdey Tedy THIUH: HUMgT: ” SRARE HEd?

12) FuaRTE: F:?

B) §8g 99 |HmM4|

1)
2)
3)
4)
5)
6)
7)

Uerde @ THidied PEaE! — qEad FReAd|
FOEN GEHY: ......... 2k AR |

3x5=15



C) I=g FamTt gfd: frdam 5x3=15

D) W& YU« A | 10x1=10
1) oS (’: ~ . ~ .Wl
2) SRY: ZENEH: FMAII (S|
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RKMVERI/DSP/MAIS/23-28/D2024/SK-441

SK-441 AEA0: -39, TOETHE

FISEN: - EREIH, qUITET: - 50

A) 3 SIEAY I HTE | 1x10=10
1) A qHuY: e i ?
2) FHEhRIESHI fH?
3) e wer gfd FEiE: ?

4) UM Hiciaan?

5) T@: I9H FHdd: R?
6) HRIIISET FEd HSFE S ?
7) SUUERRAG TUTEH: e : ?
8) el fhH?
9) SAfeaaiTaT=aTeA: &?
10) 1 T FRFA1?
11) ATHRN H: FHid A FeRian:?
12) 8: @rad 3099 Hieal: Jan:?
B) sniter 99 v §HER| 3x5=15
1. FHOT FaTeh: ST €S AREAT |
2. ErATEISEUT HIGREX S|
3. goletgdiawe: .. &fd ey foad|
4, IUEHSHUT (&9
5. TE] 92 U9 [Ruditas e &= ... fomeaal
6. FEFTTuTeel fefeTad|
7

. SUFd I 7 R 3hd 2k 1 SUN? HI?



C) snfieH A s ww T 5x3=15
1. SEASYsaedl: Ul HigRl AREE|
2. FeeEF HIgELul AT
3. TN RSHIH: SIS HINH o= |
4. FEH: T TG FPEHT [rgaa|
5. FeMTETgIa ScTie, FIRHT AR

D) ag=3H T faqupal 10x1=10
1. ST TSR, (FETad|
2. AREAREEEUl AT el MUged|
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SK-451 SH& % SHIEd: Taa:

FISEN: - EREIH, qUITE: - 50

A) 95 T VA IAEA 1x10=10
1) udigmme: fhfe $= farfa?
2) %l AETRA: FARTEI?
3) % A EREEA?
4) TuiEEEATIAT: H?
5) @Ad: awd N = 3d & 3g;:?
6) SETGHT E: Sid wu HAH?
7) weH fagia: ®?
8) gdma: GANg: F:?
9) TEAH: FH TRISA?
10) TRGT: F@T: Figam:?
11) FRURHERE: &:?
12) FEITcHE RIS Hidfad:?
B) q8g 99 G| 3x5=15
1) gHRTE®A FuE|
2) qavTgs gRE — gf i s
3) IS I SRR — AT ek R |
4) BEEA @G agHaw] — TN HINH AT
5) areHTEd: AFIEE Fd: A
6) = HHIEET Haw] — 2 Wi ATE|
7) TR — 3 Wik |



C) 9=9g J9q: @A« | 5x3=15

1) E4: EEURTIHHINE AN
2) X 2Ud — I B AR
3) SR HEGHH AN
4) o it — 3fd @ik =)
5) SHUHHAH IR AR
D) &di&: HI| 10x1=10
1) GHTEIERIY SFOHNY Ee: e Fd: 7 Wadiid SAReATd|
2) AT Hd @Uedd|
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SK-521 GEhaTIvaa:
;- EETH quITE:- 50

A) TG GE TAT: AT | (B 994 &0 S@&EfE)  1x7=7
1) Tpfor-zreges fedtatenTent w1t &
2) TIJ-Sed TR Hifel ST
3) I5H-TEET TYHEHIGE TR FH1i=l &7
4) FETHE-TEEE JAAhT Fie ST
5) R]-TeEE TEIhI il &9
6) ITATIH-I(eqEd GFHITSITRT FHifel &I
7) - TS TR il ST
8) Ifun-areaed TGTaRRT Hifel &N
9) Hfd-ZTeatd T Hii« &1
B) SaivgWy |8 S91: @A | (Bg a9y &t &) 1x7=7
1) 20g-Hrdl: S-SHN TGRS FHi STl
2) Ug-al: SIE-SHN HATIE Flfel &I
3) W3-l SG-SHN ITAIEY HI+ ITUT|
4) F-grat: WA fffog-SHR TeHYey F1id SqToT
5) Gol-HIal: Tl f5g-ehi THTES Hife 91T
6) -9dl: FE-SHN HAHIE Hlf«l ST
7) -G TERUEH: [l -SHN STHIEY Hif &1
8) FM-UMdi: BE-FHN ITAHIEY i« EITT|
9) TG [AL-SHR HARGEY FHlT FIIUT|



C) A= g FRF WA 2x2=4

1) wfEd®ue,..| 3) eEify..
2) VISR .|
D) I9H =t Gfed Fawg, @l afafsg® Fagl 0.5x10=5

1. gfea: 11. |feafrsse:

1) T3, 1) ¥

2) T 2) dEIHSE:

3) S TE 3) ¥

4) T e, 4) G

5) =& 5) dreeal

6) ISR 6) geuaH:

E) ifafddy agmam qamAl aeuei @epagare feewg)l  1x5=5
1) Fawsl 2@l CINRICE FFHHC@ (TR 7l A5 T FACR |
2) Wie $ FHCS 0 NI T FACEH |
3) T4 Ta NG 2RebTE WreTF Ty ot v (12 2l Sy vee
oA |
4) S S TS0 TSR WHNHFAE 06! AT |
5) (A Tl $iferel 27, (T K SR AH |
6) 5TC 7T FoTH BI@ NG!S 917 FIH SoFES AR ?
7) e IR AN FERIF (4TS I Al ?

F) a9m&# q=@mHi armt Ifaaeanin foewg | 1x5=5
1) feedfmed_ (3/E)/8) wa &

2) (FE/F ST /Hge) Rt 78 difq: e add|

3) T T Aieay Freuead, (Idae: /e /gRrdeed: /gaar) |
4) 3@ O T A - (STOTITcl/>0T /51071 |




5) THI T faied 9 - (Tead: [TTea: /iTssid) |
6) TE: ---(TAARL/ TaH,/ T F@l Fumie|

7) WECH: G e (et /era) |
G) ey qATFdard THS TT: THTET: | 1x17=17
1) o RAowHEE THFw S| (T=aRad-H)
2) @: 4 HEl Y EEQTA? (F=AaREdH)
3) WA: AU RT3 | WA TS Fgard | (Ia1/39)
4) farg: e anieon &) g S st (39
5) g T Il (F)

6) Tsivg: faee: il (Thed)

7) TH: AU S @l | (FAWT:)

8) T =& THE(Y) fasd G (=)

9) HidT TaT T T2Fd! agl TH: MR Ffd| (AT TEH)
10) TH: T G STl 391 T G2 Feaeet: | (TREIST)
11) 3 99 Wad gH T8I | (Tr=aaREd-)

12) @ A AR (FTEaRad)

13) BE: L TSl | B ST G Svd | (Fa1/99)

14) F%: SR TE Sl | Fh: AR ST qaid | ()
15) JreHT ®: Hiddi fS@d| (F)

16) TH: I M| (THaq)

17) Ga: ST Aiegt a4t | (FeT)

18) THal: I g S| (2AF)

19)%31)1:41191: SRR Ufed dal ~Ia=: 9eH JREE| (WE

20) TEL: +r6<h qieaqar| 0T d SRigid)l (TEREISTH)



RKMVERI/DSP/MAIS/24-29/D2024/SK-521
SK-521 G&haTIvaa:

FSEM:- § &R 2¢ feamay Rovy quITET:- 50
A) 91 9999 I AT 1x10=10
1) ST SHIORIAT: 59 §: £ 2 6) TqUcd: HiA o1 Hafa?
2) fafufoeasr: Fya¥igagsad ?  7) W1 S AiHRee o1e: &: ?
3) ST FHH A e 8) A T v & foerd |
4) FaS Y F: FHRN: ? 9) mRiifdg-&qu T AR fowd|
5) U-ddl: wIE €99 ? 10) FSHHNIT T a1 foAed|
11) fercamn: Famaiae@iedr: 2ear: Hie oy sgeaw ?
12) TqU-2eaE Eiliess; SEiTenTth: agaa- fh &9 ?
B) forl 99wt 79 S [ian eeord T faea) 2x5=10
1) HAgERe ... I 5) STedERA...... |
2) G GO ... I 6) TATHIEH ....... I
3) G TAM....... I 7) SO E I
4) JEEHAEEA ...
C) TG I HH TSHRY &A1 fosra | 1x10=10

1) sfigwd  2) gIERE:  3) FFELHC (AR
D) 379: JA=TH THE FaATrAi6-EqToT fo5ea | 1x4=4
1) ™  2) #@d:  3) dR
E) {2 tag 993 |9 qan«| 1x7=7
1) 3 O 989 fUau: T TRH S| (SERT IREqad)
2) it SRR AR RIS STl JoIiT STeaded | (SEi aRadad)




3) TR BERE: JEAHI SEw: F 4iFwd | (SERT TREqgq)
4) TEl 2 S IrEE: | (SERT aRaqad)
5) HEI g d S /i 9xdiedl (W 9Raadd)

NX_a o

6) TEA: TAH: T IANTA: | IUEET: T Irasled | (T f5&w)

7) HE S WAl I | T siated | (MTaEaE (o)
8) W S G Weled | T Jud T | (WIHEET fo5eTH)
9) B TG: qUN: Fafed| G Gt I (MTaEEw foseam)

F) STaTd 39 I taigaaqe: i ara sHieda| 1x4=4
1) d 3) FHd 5) w
2) &l 4) 6) q

G) 2N X T+ ATPNEIAT AFagd| 1x5=5

Falrad, d HeldTes PREER i ATeaTd, ®id SRa: M &dE[: §HRT,
O THE ATH A1, RN A Gd:, a7 Hen i)
HAGR=S: O S9H T, FEli R, FHl AETR:, I o H = |

TAEHE-IR=3e-G0aN: €: UcdE d ol S-REIdusEs da TS|
TS | T STHR-GIdeR-I6Tq Jel, a6 qaftaat gt ggia &,
TS & | R T=3e IR, dcgea: - 'fFe Thl: thid: Ia-: T
F' 3 FA=PH| | = FREC: T1a: TG Fedll, TEAT JATg: a6
RiggN el = Egemarat SR 21 TeEeAfaTEr TEmE: 56
TIETd, ST | Fd T, STFRT ANSIG T+ < HIuTTd &, 3T 1 F0d
e et e = g fafegaiet, o= g foona: gRenas

TeTd| T feTd Ui diiel T=Rdi« &: SeER|



RKMVERI/DSP/WW/MAIS/24-29/D2024/1P-381
IP-381 Indian Philosophy

Full Marks — 50 Time- 2 Hours

A) @ @ w5 &tga Sea w8 (in 1 or 2 lines) 1x10=10
1) MY w1 og < 62
2) eI ePpog AR 5 JCer?
3) (oY MHINCE (e TR AT el =Y?
4) IS ACE (e AL ALY FeA| 27?
5) ofegA (FIsha FAL 2 Al A [oes?
6) WL Tt 6 5 eiey FiFla 91 200R?

7) IR FICF ICT?

8) WL A eIPfS FIF JCEA?

9) (o Mo ST (1 T AFR? FIN (=0l |
10) apfox &% e 5?

11)7MfgS T2FR A G Seoy T2

12) ‘aft 96—l eforF QIR (&2

13) ‘Qror *=fog o 52

14) 1! wf Q1ca foegfe It Ie?

15) T4 (e &P (& o oFfe’ el 27?2

B) @ (F9 «i5f &rq €& we (in a paragraph) 3x5=15
1) RS Q32 (ST FHfTeTa SICys oA fefs 4 |

2) TGS A2 SIS AN W A1 (el 3 |
3) AR T SEICE B @y 145 4 |
4) G T AT I @32 O R ermrasfer amen &4 |



5) SR mf eFfe W3R o [odie FerRa 2ewl sres filfie =31
Ol Gl ol HL?

6) CIT M SR e O e 5145 54 |

C) @ @I f&=S &rea Sed wie (in about a page) 5x3=15
1) R A weftey & faegifed 3o 27 @3 owes oFfeq Fae
[ 4 |

2) VeFRAImE 7 e 1 4|

3) st v S foegfewler 7o 54 |

4) I T ST T a7 wesfe F5fB At I3 9 |
5) IRy T eipfon wfeg e Fhevefler 5r4s 34 |

D) (T (I 936 YT7 Te wie (within two pages) 10x1=10
1) AR 7T 2Je0ad Ay M Jievafer qpes 1 |

2) AR v [ ©ItT Nedam e 7kl afefde 1 2re? e
Rifde ©IE 3o/ 4 |
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RKMVERI/DSP/MAIS/24-29/D2024/EN-611
EN-611 English

Full Marks - 50 Time- 2 Hours

A) Answer the following questions in complete sentences.
1x5
1) Name the tribe mentioned in the Hemmingway story.

2) Why did the narrator predict that Harris would grow up
to be like Uncle Podger?

3) “What immortal hand or eye” - Whose immortal hand or
eye is referred to here?

4) Who is the poet of “Stopping by Woods on a Snowy
Evening”?

5) “What he hath lost noble Macbeth hath won.” - What
has Macbeth won?

B) Choose the correct alternatives. 1x3

1) It is fear that is the greatest of all
a) Anomalies
b) Superstitions
c) Fears
d) Anxieties
2) The word opposite in meaning to “Transient’ is
a) Permanent
b) Transformation
c) Omniscient
d) Temporary
3) The word similar in meaning to ‘Symmetry’ is
a) Haphazard
b) Harmonious
c) Erratic
d) Wholesome



C) Make phonetic transcription of the following words
(Any 2) 1x2
1) CAT
2) UGLY
3) THREE
4) SHOWER

D) Answer the following questions. (Within 100 words)3x5
1) “I'm terribly sorry I brought you along, Nickie” - Who

said this and to whom? What made him say this?

2) Name the three titles of Macbeth predicted by the
Witches.

3) What did Uncle Podger do with the hammer?

4) What did the horse find to be ‘queer’?

5) “What the hammer, what the chain...” - Explain the
usage of the imageries in this line?

E) Answer any three (3) of the following questions (Within
150 words) 5x3

1) How was Macbheth’s bravery narrated by the
ambassador?

2) ‘What the hands did seize the fire?” What is the myth
that the poet alludes to in this line?

3) "I don't know. . . . He couldn't stand things, I guess."
Who said this and to whom? Who is the person referred
to here? What did the person referred to do?

4) How do you assess the attitude of Uncle Podger?

5) How according to Vivekananda Indian spiritual
tradition would come to the rescue of the modern
world?

F) Write a letter to your brother who is about to start his
hostel life making him aware of the dos and don’ts of
the same.
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RKMVERI/DSP/WW/MAIS/24-29/D2024/EN-611

EN-611 English

Full Marks - 50 Time- 2 Hours
A) Answer the questions : 5x4
1) What was the primary reaction of Mini in her first

2)

3)

4)

meeting with Rahmun ? Or 5

Sum up the feelings of Rahmun on the day of Mini’s
wedding.

What are the three visions mentioned by the speaker in
‘My first vision of India‘ Or. 5

How does the speaker explain his First Vision ?

¢

‘Fair is foul and foul is fair ‘——-What is the inner
meaning of the quoted line in opening scene of
Macbeth ? Or 5

How does Ross describe the course of battle before
King Duncan ?

Describe why the poet calls his wife ‘a Phantom’ ? Or 5

Describe why the poet calls his wife ‘a Perfect
Woman ‘ ?

B) Attempt any five questions — 5x1

a) Who is she in the poem ‘She was a Phantom of
Delight’ ?

b) Who delivered the lecture * My Vision For India ‘?

c) What was gifted by Rahmun to Mini in his first
meeting ?

d) How does Ross call Macbeth ?

e) What is the meaning of father-in-law’s house to
Rahmun ?

f) Name the poet of ‘She was a Phantom of delight ‘?
Group - B

C) Correct the spellings - 2x1

Aparition ,Recieve



D) Correct the sentences - 3x1

a) His father is out of door .
b) There is not anybody in the room.
c) Take care of your luggages in train.
E) Write a story with the help of the outlines given 10

A thirsty crow comes to a pitcher —water too low down
—the crow picks up stones and throws them into the
pitcher —the water-level rises —the crow can drink
water .

F) Read the passage carefully and answer the questions
10

A young lad was passing along the road with fruits
in hand .A number of monkeys followed him nd tried to
snatch them .The lad began to run in fear nd so the
monkeys became bolder nd chased him .Suddenly he
heard a voice * Do not run but face the monkeys boldly
and they will stop .The man was a monk .The lad
became bold and faced the monkeys who stopped
disturbing him .The lad went on fearless through the
monkeys who ran away . In future this lad came to be
known as Swami Vivekananda .He taught others ‘Be
not afraid of anything .It is fear that is the cause of our
miseries ‘.

a) Why did the young lad run ?

b) What was the result of his running ?
c) What did the voice say ?

d) What did the lad do then ?

e) What is the lesson the lad learnt ?
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RKMVERI/DSP/MAIS/23-28/D2024/EN-613

EN-613 English

Full Marks - 50 Time- 2 Hours
Group - A
A) Answer the questions : 5x4
1) Why did Loisel feel unhappy in her married life ? Or 5

How did Loisel and her husband feel after loss of
necklace ?

2) In R.N.Tagore’s view ,why should the Indian people be
grateful to the English people ? Or 5
What does R.N.Tagore mean by °‘liberal humanity ‘ of
the English people ?

3) Why does P .B.Shelley compare the skylark bird to a
‘Poet  and a ‘Glow-worm’ ? Or 5
What does P.B.Shelley say in the last stanza of the poem
‘To a Skylark ?

4) Give the central message of the poem ‘ A Dream within
a Dream ? Or 5
What is the meaning of the expression ‘Grains of the
golden sand ‘?

B) Answer any five questions 5x1

1) Who wrote the poem ‘A Dream within a Dream * ?

2) What kind of poem is ‘To a Skylark ‘?

3) Who wrote the story ‘Necklace’ ?

4) Whom did Loisel borrow the necklace from ?

5) Where did R.N.Tagore deliver his speech on ‘Crisis of
Civilisation  ?

6) How old was R.N.Tagore while delivering this speech ?

Group - B
C) Correct the spellings : 2x1

Eleganc,Antesocial



D) Use proper prepositions : 3x1

E)

F)

1) The thief ran ————with ornaments.
2) Ican’t call ——my friend’s phone no.
3) I congratulate you —— your success .

Write a letter of invitation to your friend to spend
summer vacation in your village home . Or. 10

Write a letter to your friend about your hobby .
Read the passage carefully and answer the questions 10

A good entertaining book is effective amusement
for a man after his day’s work .It relieves his home of its
dullness .He enjoys himself there and may forget the
evils of the present moment .His day’s work becomes
joyful and he finds time to think also .If I am asked to
find a source of happiness in life ,it would be a taste and
passion for reading books .Everyman must be happy
until and unless he is given bad ,dirty books in hand
.Through good books,everyman must be familiar with
wise and pure thoughts of great men in history.

1) What is the best amusement for a man after his day’s
work ?

2) What is other benefit also ?

3) What is the best source of happiness for a man ?
4) How study of books can do good for man ?

5) Give a nearest meaning for ‘dullness’.

6) Give opposite words for ‘pure’, ‘familiar’ ,’wise’ and
‘dirty *
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EN-615 English

Full Marks - 50 Time- 2 Hours
GROUP-A
A) Attempt questions as directed : 4x5
1) Comment on character of Kali in the story ‘Sweets for

Angels ‘ Or
How was Kali humiliated on public road ?

2) What according to Bacon are benefits of study ? Or
How ,according to Bacon,study may be an exercise and
a delight ?
3) Give the central idea of Shakespearean sonnet no 14.
Or
Give estimate of Sonnet 14 as a Shakespearean sonnet.
4) Give the central idea of the poem ‘On Teaching’ Or
Is there anything new in the poet’s attitude to teaching
nd learning ? Discuss with ref. to the poem ‘On
Teaching
B) Attempt any five : 5x1
1) What kind of essay is ‘Of Studies’?
2) Who wrote the essay ‘Of Studies’?
3) What is the profession of Kali ?
4) Who wrote the story ‘Sweets for Angels ‘ ?
5) What is said in the last two lines of Sonnet no 14 ?
6) To which country did Kahlil Gibran belong ?
GROUP- B
C) Draft a dialogue between father and son about the
merits and demerits of On-Line education . 10
D) Change the voice : 3x1
1) Mother teaches her daughter music .



E)

F)

2) The boy broke the mirror .
3) Please open the front door .

Correct any two spellings: 2x1

Splendeed ,Necesary,Seperation
Read the passage carefully and answer the questions:10

There lived in Persia two painters but it was
very difficult to judge who was the better of the two .It
was decided each would draw a picture and the judges
would decide who had done better .One of the painters
painted a bunch of grapes which looked very natural
and birds came and started pecking at them .The judges
wondered at the skill of the painter .The other painter
had drawn a screen before their eyes.The rival painter
thought that the picture was behind the screen nd went
forward to see it .But he was surprised to find no screen
but only the picture painted on the wall .The judges
were speechless nd honoured the second painter
because he had deceived man but the first painter had
deceived birds .

1) Why was there rivalry between two painters ?
2) What was decided to judge their paintings ?
3) What was the effect of first painting ?

4) How did the second painter draw ?

5) Why was the second painter honoured ?
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CA-621 Computer Applications (Theory)

Time: 2 hours Marks- 50

All questions are compulsory

A) What is instruction set in computer Language ? How is the instruction
transmitted in a computer system ? 5+ 5)

B) What is Register ? Write down the names of the diferent kind of
register with eaxmple? Draw the block diagram of Computer system ?

2+5+3)

C) Compare:- i>RAM & ROM , ii> HDD & ODD (5+5)

D) What is Encoding ? What is Unicode ? IF anyone typed “I am” on the
keyboard the how computer understands it ? [ [ = 73 ,a = 97, m =

109] (2+3+5)

E) Convert the following numbers as per the instruction :- (3+3+2+2)

i> (125)s= (?)1s
ii> (175)10 = (?)s
iii> (7B)1s = (?)2
iv>(1111101)2=(?)10o
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CA-621 Computer Applications (Practical)
Time: 2 hours Marks - 50

A)

A)

B)

C)

D)

Instructions in the exam hall:

1) You are not allowed to use internet during the exam.
2) You are required to stop answering 10 minutes before the

specified duration in order to prepare for submission.

3) Create a folder with your name inside the Music

Directory and store all your files there.

Question 1: Marks 15

create invitation letters for 8 invitees in writer using
MailMerge feature mentoining the name , address and
salutations for each invitee. Among them 3 of the invitee
must be female .

Question 2: Marks 15

Create a attendence sheet for at leat 10 students for 10 days
and count the percentage of attendance using the appripriate
function in calc spreasheet . ( Use the freez rows and columns
feature to make the attendance sheet visible properly )

Question 3: Marks 10

Create a marksheet of students in calc spreadsheet for 10
students . Grade the students such a way that marks > 90 is
trated as “A+”, marks > 70 is trated as “A”, marks > 35 is trated
as “pass” and marks <35 is trated as “Fail”. Also mark the
“Fail” student grade in red colour . ( Use the if statement
alongwith conditional formating ) .

Question 3: Marks 10
Create a Slide show presentation using the pictures given
inside the slide folder in Music Directory.

The pesentation should contain at least 5 main slides and in
each slide there should be a RKM logo and RKMVERI footer
text .( USE the slide master feature ).

Apply proper Animation and trasition effect in your slides to
make it wonderfull.
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CA-621 Computer Applications (Th.)

Time: 2 hrs. Full Marks: 50

A) Fill in the blanks: 1x10=10

1)
2)
3)
4)

5)
6)
7)
8)

9)

10)

Raw facts or figures are called
memory is volatile.
is one-time programmable ROM.

The process of writing data to an optical disk is
called

is the smallest unit of information.
1 = 1024 MB.
Motherboard is an hardware.

is an example of first- generation computing
devices.

Intermediate results during program execution are stored
in

language is machine dependent.

B) State whether the following statements are true or false:

1)
2)
3)
4)

5)

1x5=5
Java is an example of assembly language.
We can move a file from one storage device to another.
Primary memory is faster than secondary memory.

Compiler and operating system is an example of
application software.

Logical errors are detected by the compiler.

C) Answer any two questions 5x2=10

1)

2)

Convert decimal number (105.15),0 to binary number system.
[5]
Subtract (111.111), from (10101.01), [5]



3) Convert octal number (2035)s to hexadecimal number system.
[5]
4) Convert hexadecimal number (42FD);s to octal number system.

[5]

D. Answer any five questions: 5x5=25

1) Write short notes on Third Generation of computers. [5]

2) Subtract 34 - 22 using 8-bit 1’s complement arithmetic
[5]

3) What are static and dynamic RAM? Briefly explain [5]

4) Subtract 27-75 using 12-bit 2’s complement arithmetic.
[5]

5) Write short notes registers of computer. [5]

6) State the differences between main memory and
secondary memory. [5]

7) Add the binary numbers: 101011.101 + 11111.011 [5]
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CA-621 Computer Applications (Pr.)

Time: 2 hrs. Full Marks: 50

Instructions:

a) Save your document with your name as the filename.

b) Perform all the tasks as specified in the questions below.
c) Ensure proper formatting and accuracy in your work.

d) Save the document periodically to avoid data loss.

Answer any 5 questions:

1)

2)

Create a Database named Term 1 in Libre Base. Insert a
Table named Students with fields Rollno, Name and
TotalMarks (out of 500). Insert ten records into this table.
Also, create a Query to display all the records having

TotalMarks above 90% for awarding scholarship. 10
Type the following paragraph into a new Libre Office
Writer document: 10

Maria and her family went on a trip to the

mountains last weekend. They woke up early in the
morning and packed their bags with food, water, and
warm clothes. After a few hours of driving, they arrived at

a

scenic spot with a beautiful view of the mountains. The

family spent the day hiking, taking pictures, and enjoying
nature. Maria’s younger brother, Leo, was especially
excited to spot some wild animals along the trail. By the
end of the day, everyone was tired but happy. They
returned home with memories of a wonderful adventure.

a) Change the alignment of the paragraph to Justified.

b) Change the font size of the paragraph to 12 pt and the
font style to Times New Roman.

c) Add a title above the paragraph, such as "A Trip to the
Mountains."

d) Format the title with Heading 1 style and center it.



3)

4)
5)

6)

e) In the paragraph, change the color of the words
"mountains"” to blue.

f) Highlight the words "wonderful adventure" in yellow.

Use Mail Merge feature to send a letter to all your friends
giving them brief description of puja recently performed
at your home. Insert at least five data containing name,
address, pin code and city. 10

Type a paragraph in Sanskrit as instructed. 10

Create an Impress Presentation of about 5 slides on the
‘Importance of Clean Environment’. The presentation
should contain images, transitions and animation effects
to make it interesting. 10

Perform the following in Calc Document: 10

Create a table of data containing marks of 6 students in 4
subjects. Create Column chart using the data. Apply chart
title, legends, data labels, data table etc.
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CA-623 Computer Application (Th.)

Time : 2 hours Marks - 50
A) Choose the most appropriate answer 1x10=10
1) What does the command \footnote{ } do in LaTeX?
a) It adds a footnote to the c) It creates a new
bottom of the page paragraph
b) It creates a new bold d) It sets the text to italic
section
2) What does the command \emph{ } do in LaTeX??
a) It creates a new bold c) It creates a new
section paragraph

b) It sets text to emphasize d) It sets the text to bold
3) What is the purpose of the command \pagestyle{ } in

LaTeX?
a) It sets the font style of c) It sets the page margins
the document
b) It creates a new section d) It adds page numbers to
in the document the document
4) What does the command \textsuperscript{ } do in LaTeX?
a) It creates a new c) It creates a new
superscript section paragraph
b) It sets the font size to d) It sets the text to
superscript superscript
5) LaTeX code for A = B
a) $ A\notequal B $ c)$A\negB$
b) $ Al=B $ d) $ A\not B $
6) In mode, over-application of the tool will
produce noise in GIMP.
a) Sharpen c) Dodge

b) Blur d) Smudging



7) The helps you to select areas of the current layer
on based on color in GIMP.

a) Text Tool c) Foreground Tool
b) Fuzzy Tool d) Croppring Tool
8) How can you flatten an image in GIMP ?
a) Layer -> Flatten Image c) Transparency -> Flatten
b) Mode -> Flatten Image Image
d) Image -> Flatten Image
9) The tool allows yo select a drawing with free-hand
in GIMP
a) Fuzzy Selection c) Lasso
b) Text d) Bucket Fill
10) What is the keyboard shortcut for Eraser tool?
a) Shift + E c) Alt +E
b) Crtl +E d) Shift + Ctrl + E
B) State whether the following statements are true or
false: 5x1=5

1) GIMP is open source image editing tool.
2) White is the default color of foreground in GIMP.
3) GIMP uses only RGB and Gray Scale mode.

4) In LaTeX, package ‘polyglossia’ can only be used to
display multiple photos.

5) In LaTeX, package ‘multirow’ can be used to combine
multiple rows in a table.
C) Answer any 5 of the following questions: 5x2=10

1) What is the function of the \pagestyle{fancy} command in
LaTeX?

2) Explain the purpose of the \rfoot{Dept. Of Sanskrit and
Philosophy \thepage} command?

3) What is the difference between ‘paintbrush’ and a ‘pencil’
tool in GIMP?

4) What is the difference between ‘gradient’ and ‘pattern’ in
GIMP?

5) What is the role of the ‘ragged2e’ package in LaTeX?
6) Why are the ‘amsmath’ and ‘amssymb’ packages used in



the LaTeX?
7) How do you use the ‘Text Tool’ in GIMP?

D) Answer any 5 of the following questions 5x3=15
1) What is a LaTeX section heading?

2) What is LaTeX document structure?
3) What is Latex Packages?
4) What are the list of LaTeX?
5) How do you create new brush in GIMP?
6) How do you create new pattern in GIMP?
7) How do you use “Free Transform” tool in GIMP?
E) Write a LaTeX Program to execute following
expressions 5x2=10

1) Write a LaTeX Program to execute following expressions

.
Q) \/f(X)=: f (XO)(X

o n!

_Xo)n

X+
b) J|xy|<u
2
a@+b’ b*+c? +d
C) p2+ q2 q2+r2 r2+p2

2 2 2 2 2 2
X+y" y+zt z+x

—bi\/b2—4ac
2a

© Ny SO, 2% Nat + S0

d) x=
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CA-623 Computer Application (Practical)
Time: 2 hours Marks: 50

A) Write a LaTeX programme that can generate a pdf like
the Wall Magazine Vivekabhaskara. 25

Prepare the following pages

1) Front page (Cover page)
2) Table of Content
3) The Editorial Page

4) Any two other pages of your choice

B) Take an image of Prajna Bhavan. Then change change
the Text “Ramakrishna Mission Vivekananda
University” to “Ramakrishna Mission Vivekananda
Educational and Research Institute”. [Note: The image
should look like real image; not an edited one] 25
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CA-625 NLP
Time: 2 hours Marks: 50

A) Write brief notes on any five of the following 4x5=20
1) Turing Test
2) Al Winter
3) Al Boom
4) Neural Network
5) Deep Blue
6) LISP
B) Write Notes on the following 10x3=30
1) History of Artificial Intelligence
2) Tree Adjoining Grammar

3) Lexical Functional Grammar

kkk



RKMVERI/DSP/MAIS/22-27/D2024/ES-631

ES-631 Environmental Studies

Full Marks - 50 Time- 2 Hours

A) Answer any ten of the following (in 1 or 2 lines)1x10=10

1)
2)
3)
4)
5)
6)
7)
8)

9)

Name Ramser sites in West Bengal.

Name two environmental movements in India.
What is the full form of ITUCN?

Who coined the term ‘Biodiversity’?

What is Key Stone species?

What do you mean by food?

What is sheet erosion?

What is the shape of pyramid of biomass in aquatic
ecosystem?

What is niche?

10)What is the purpose of Anemometer?

11)How many biodiversity hotspots are there in India?

12)In which year was the wildlife protection act

introduced?

B) Answer any five of the below (in a para) 3x5=15

1)
2)
3)

4)
5)

6)
7)

What is species diversity?
What is Alpha and Gamma diversity?

What is the difference between consumptive use value
and productive use value?

What is national park?

What is the difference between In-situ and Ex-situ
conservation?

What do you mean by Biodiversity Hotspot?
What is Human Development Index?

C) Answer any three of the given 5x3=15

1)

2)

What are the major reasons for over utilization of
surface water resources?

What are the functions of FSSAI and what is the



purpose of Agmark?
3) State the causes of desertification.
4) What are the sources of renewable energy?

5) What are the consequences of exploitation of mineral
resources”?

D) Answer any one of the following: 10x1=10

1) What are the benefits and problems of dams?
2) State the advantages and disadvantages of wind energy.
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	a) Layer -> Flatten Image
	b) Mode -> Flatten Image
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	d) Image -> Flatten Image
	9) The _______ tool allows yo select a drawing with free-hand in GIMP
	a) Fuzzy Selection
	b) Text
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	d) Bucket Fill
	10) What is the keyboard shortcut for Eraser tool?
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	b) Crtl +E
	c) Alt +E
	d) Shift + Ctrl + E
	1) GIMP is open source image editing tool.
	2) White is the default color of foreground in GIMP.
	3) GIMP uses only RGB and Gray Scale mode.
	4) In LaTeX, package ‘polyglossia’ can only be used to display multiple photos.
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